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Release Notes

This document contains information about using NCDware 5.0.129
with NCD network computers (NCs). Review this document before
installing NCDware 5.0.129 or using NCDware manuals.

Highlights of This Release
The following section summarizes the new features and changes in
this release. NCDware 5.0.129:

❏ Includes support for the new Explora 400/450 series and Explora
700 network computers. See “Explora 400/450 Series” on page 23
and “Explora 700” on page 24.

❏ Includes distribution on CD-ROM and 12 MB Quick Start PCMCIA
card for Explora, Explora Pro, Explora 400/450 series, Explora
700, and HMX network computers and on 4 MB Quick Start
PCMCIA card for Explora, Explora Pro, and Explora 400/450
series. See “Distribution Media” on page 4.

❏ Supports Java Virtual Machine (JVM). JVM is a network
programming environment for creating and running embedded
Java applets and standalone Java applications. See “Java Virtual
Machine and Applet Viewer” on page 24.

❏ Includes the Java Applet Viewer, a Java application that allows
you to run applets in an applet viewer window. See “Java Virtual
Machine and Applet Viewer” on page 24.

❏ Includes the NCD Mosaic Browser. You can use this Internet
browser to view sites on the World Wide Web (Web) and other
Internet resources, provided that you have an Internet
connection. The browser is based on Spyglass Mosaic 3.2 and
supports JavaScript 1.1. You can print from the browser to a local
printer attached to your network computer and to remote
printers. See “NCD Mosaic Browser” on page 25.
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❏ Includes the NCD Display Manager (ncddm), a host-based
daemon that:
— Enhances network computer security for NFS file access
— Provides environment variables required by local clients, such

as java and the NCD Mosaic Browser
— Makes it possible to prevent anyone but the logged-in user

from starting local clients using the remote shell command,
provided the user logs in through a login service, such as
XDM

See “NCD Display Manager” on page 27.
❏ Supports using a light pen with your NCD network computer to

perform the typical operations of a mouse—such as pointing,
clicking, dragging, and positioning—without having to
coordinate the movement of a mouse with the cursor on the
screen. The Explora, Explora Pro, and Explora 400/450 series
include light pen support for the FTG Data Systems PXL-795 light
pen. See “Light Pen” on page 27.

❏ Provides XIE’s (X Imaging Extension) DIS (Document Imaging
Subset) for the Explora, Explora Pro, and Explora 400/450 series.
See “Document Imaging Subset (DIS)” on page 27.

❏ Includes wireless network computer support for the Explora
400/450 series. See “Wireless Support” on page 27.

❏ Includes new remote configuration parameters and changed
parameters to support new features and enhance existing
features. See “Remote Configuration File Updates and Parameter
Changes” on page 28.

❏ Includes enhancements to the NCDware installation program
(ncdinstall) to support new features. See “Software Installation”
on page 6.

❏ Includes the new NCDware Reference Manual, which is available
in hard copy from the NCD publications order form or Sales
Support. You can also access the Reference Manual on-line at
www.ncd.com/doc/ncd50ref/ or from the NCD FTP site. See
“NCDware Manuals” on page 5 and “Using FTP” on page 41.

❏ Does not provide host binaries or an installation script for VMS.
NCDware 4.1.141 is the last version of NCDware to provide host
binaries for VMS. See “Host Binaries” on page 4.

❏ Is the last release of NCDware to support PHIGS Extension to X
(PEX). See “PEX” on page 28.
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NCD Network Computers Supported by This Release
This release provides NCD network computer software and host-
based support files for the HMX family of network computers (HMX,
HMXpro, and HMXpro24), and the Explora, Explora Pro, Explora
400/450 series, and Explora 700 network computers.

Unsupported Network Computers
NCDware 3.5 was the latest release to support the following network
computers: NCD14c, NCD15b, NCD19r, NCD17c, NCD17ct, NCD17cr,
NCD17fs, NCD19c, NCD19cp, NCD19g, NCD20ct, NCD21c, and the
MCX and ECX families of network computers.

NCDware 3.3.2 was the latest release to support the NCD15r network
computer.

NCDware 3.2.1 was the latest release to support the NCD19 network
computer.

NCDware 3.1 was the latest release to support NCD16, NCD16e, and
NCD19b network computers.
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Host Binaries
This release provides binaries of host-based software for the
following host platforms:

❏ SPARC—SunOS 4.1.3 to 4.1.4
❏ SPARC—Solaris 2.5
❏ x86—Solaris 2.4
❏ HP Precision Architecture—HP-UX 10.01
❏ IBM RS/6000—AIX 4.1
❏ SGI—IRIX 5.3
❏ WinFrame—1.6 or later
NCD has not tested and does not provide Technical Support for the
Motorola binaries included in this release.

Note NCDware 5.0.129 does not provide host binaries or
an installation script for VMS. NCDware 4.1.141 is
the last version of NCDware to provide host binaries
for VMS.

Distribution Media
The release is available on CD-ROM, 4 megabyte (MB) Quick Start
PCMCIA cards, and 12 MB Quick Start PCMCIA cards.

The CD-ROM contains the NC software, including all modules and
support files (see “X Servers in This Release” on page 7).

The PCMCIA Quick Start cards contain the NC software and a subset
of modules and support files (see “Quick Start PCMCIA Cards” on
page 20 for a list of modules on the Quick Start PCMCIA cards).

License Requirements
NCDware includes features that require licenses for operation. They
are OpenGL, the Video Player and associated software, Starlight
Networks’ StarWorks software support, NCDnet, 3270 Terminal
Emulator, DPS (Display PostScript), XIE (X Imaging Extension), the
local Motif Window Manager, XRemote, PEX, JVM (Java Virtual
Machine), the NCD Mosaic Browser, and wireless terminal support.

If you do not have a license for a feature that you need, call a Sales
Support person at (650) 694-0650.
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NCDware Manuals
The following manuals are new or revised for this release of
NCDware:

❏ NCDware Publications Roadmap, a general index to all NCDware
and NCD hardware manuals

❏ NCDware User’s Guide, an introductory manual providing
information to assist users in becoming productive with their
NCD network computers

❏ NCDware System Administrator’s Guide for UNIX Systems, a
manual for UNIX system administrators responsible for setting
up NCD network computers for networked use and for setting
up users’ work environments

❏ Remote Configuration Parameter Quick Reference, a summary
description of remote configuration parameters

❏ FLEXlm End User Manual, a detailed description of how to use
and configure FLEXlm license management software

❏ Using the 3270 Terminal Emulator, a description of how to use and
customize NCD’s local 3270 terminal emulation software

❏ Installing Your PCMCIA Card, a description of how to install and
use your PCMCIA card with your network computer

❏ NCDware CD insert, a description of how to install NCDware
from CD-ROM onto UNIX and WinCenter hosts. Use the
installation booklet in conjunction with these Release Notes and
the NCDware System Administrator’s Guide for UNIX Systems. This
booklet is inside the NCDware CD-ROM cover.

❏ NCDware Reference Manual, containing details about many
aspects of NCDware and alternatives to some of the procedures
in the NCDware System Administrator’s Guide for UNIX Systems.
The NCDware Reference Manual is available from the NCD Web
site (www.ncd.com/doc/ncd50ref/) or from the NCD FTP site (see
“Using FTP” on page 41). You may purchase a hard copy volume
using the NCD manual order form, or contact Sales Support (650)
694-0650.
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Software Installation
This release includes an installation program (ncdinstall) for
installing NCDware on the UNIX hosts for which it provides binaries.
The ncdinstall program installs:

❏ X servers in /tftpboot

❏ Server modules in /tftpboot/modsmodel, where model is the
terminal model, such as modshmx

❏ Browser help files in /tftpboot/help

❏ Java classes in /tftpboot/java

❏ Host executables in /home/ncd/5.0.129/hostside/host, where home is
your working directory and host is the host, such as SunOS.
/usr/bin/X11/ncd is linked to /home/ncd/5.0.129/hostside/host.

❏ Configuration files (ncd_std and an example configuration file),
keysym and color databases, and login-related files in
/usr/lib/X11/ncd. (If you are running secure TFTP, ncdinstall places
the files accessed using TFTP, including X servers, fonts, and
configuration files, under the secure TFTP directory.)

The setup program installs NCDware on WinCenter hosts running
WinFrame 1.6 or later. The setup program installs:

❏ X servers (Xncdhmx, Xncdxpl, and Xncdxpt) in c:\tftp_dir

❏ Supplemental X server files in c:\tftp_dir\modshmx,
c:\tftp_dir\modsxpl, and c:\tftp_dir\modsxpt

❏ Configuration files, font files, and supplemental files in
c:\tftp_dir\usr\bin\X11\ncd where c:\tftp_dir is the TFTP
directory selected during the installation procedure.

See the NCDware CD insert for more information about installation
procedures.

See Installing Your PCMCIA Card for information about installing and
using a PCMCIA card with your network computer.

For information about manual installation, contact NCD Technical
Support.

“X Servers in This Release” on page 7 contains information on
memory requirements.
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X Servers in This Release
NCDware includes a core X server and loadable modules. The
information in this section includes descriptions of the X server
formats, module names, memory used by loading each module, and
disk space required for server files.

X Server Formats
NCDware 5.0.129 provides NCD core X servers in the following
formats (see Table 1).

Table 1  X Server Formats

Minimum Memory Requirements
Table 2 lists the minimum memory requirements for NCD network
computer models in megabytes.

Determining Your Memory Needs
Minimum memory configurations might be insufficient for the
features that you want to use. Use the information in Table 3, Table 4,
and Table 5 to determine whether you need to increase the memory
in your NC to run the components you need.

Format Description
Core Server

Filename

Downloadable X server image files for downloading from the network when
the network computer boots.

Xncdhmx
Xncdxpl
Xncdxpt

Compressed X server image files for copying to a PCMCIA card in the
network computer’s base and booting locally. These are the
X servers used on the PCMCIA cards. (If you plan to purchase
PCMCIA cards from a source other than NCD, please contact
NCD Technical Support for a list of supported cards.)

Xncdhmx.bl
Xncdxpl.bl
Xncdxpt.bl

Table 2  Minimum Memory Requirements

Model Memory Requirements

Explora 4 MB

Explora Pro 4 MB

Explora 400/450 Series 8 MB

Explora 700 8 MB

HMX 8 MB



X Servers in This Release

8 NCDware 5.0.129 Release Notes

In reading the tables, note that the figure for memory used is for the
first instance of a client. If additional instances are running, they
require less memory than the first.

To determine the amount of memory needed:

1. Find the features you want to use in the table for your NC model,
including the core X server, which is required for NC use.

2. Add up the total memory used by the feature modules and the
core X server.

3. Subtract the total memory used by the features from the memory
in your NC. If less than 1 MB remains, you need to add memory
to your NC to use the desired features.

For example, to run the Motif Window Manager on an Explora
network computer, you need:

An Explora equipped with 4 MB of memory has insufficient memory
to run the Motif Window Manager. It requires at least 6 MB of
memory.

If you need to add memory to your NC, use the instructions in your
model’s installation manual or memory booklet to determine the
possible memory configurations for your NC model and how to
install the new memory SIMMS.

Notes on Memory Needs for Commonly Used Features
The minimum memory configuration on an Explora and Explora Pro
network computer (4 MB) is not sufficient for running either the
Motif Window Manager or the NCD 3270 Terminal Emulator.

You need a minimum of 16 MB of memory in your NC to run the NCD
Mosaic Browser and a minimum of 16 MB of memory to run Java. If
you want to run both the browser and Java together, you need a
minimum of 24 MB of memory. NCD recommends 32 MB of memory
in your NC for running the browser and Java together.

Programs that use XIE require a minimum of 16 MB of memory. Your
memory requirements might vary depending on the applications
you are using, along with the sizes and number of images being
displayed simultaneously.

For many programs that use only the DIS portion of XIE, 8 MB of
memory may be adequate.

Xncdxpl 2.7534 MB

mwm.xpl 1.7465

Total memory used by Motif Window Manager 4.4999 MB
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You need a minimum of 16 MB of memory in your NC to support the
OpenGL graphics extension. Because memory requirements might
vary depending on the applications you are using, NCD
recommends 32 MB of memory in your NC for supporting OpenGL.

You need a minimum of 16 MB of memory in your NC to support
Display PostScript (DPS). NCD recommends 24 MB of memory in
your NC to support DPS.

Table 3  Memory Used on Explora, Explora Pro, and Explora 400/450
Series NCs

NCDware Feature Used Type Module Filename
Approx. Memory
Used by Loading

Module (MB)

Core X server on Explora CS Xncdxpl 2.7534
Core X server on Explora Pro 2.6835
Core X server on Explora 400 2.7183
Core X server on Explora 450 2.7199
3270 client library L libbrx.xpl 0.0179
3270 terminal emulator (ncd3270) C tn3270.xpl 0.7150
3287 print emulator (ncd3287) C 3287.xpl 0.0484
Audio E audio.xpl 0.0844
Change Setup Parameters
(ncdsetup client)

C setup.xpl 0.1622

Change User Preferences (ncdpref
client)

C pref.xpl 0.0964

Clock client (ncdclock) C clock.xpl (with
implicit loading of
libXaw and
libXmu)

0.3452

CTerm library L libcterm.xpl 0.0229
Java Virtual Machine1 C audio.xpl

jagent.xpl
java.xpl
jawt.xpl
jjpeg.xpl
jmmedia.xpl
jnet.xpl

0.0844
0.1800
0.1652
1.6082
0.2309
0.1710
0.1731
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Keymap Editor (keymap_editor) C keymap.xpl 0.2533
LAT protocol P latproto.xpl 0.0255
Lightpen support C lightpen.xpl 0.0062
Local File Manager D filed.xpl 0.0198
Login New X Session (ncdlogin) C login.xpl 0.1132
Motif Window Manager2 (local
mwm)

C mwm.xpl (with
implicit loading of
libXm and libXt)

1.7465

NCD Mosaic Browser3 C auplayer.xpl
browser.xpl
desktop.xpl
jmosaic.xpl
libprapi.xpl
nmos128.xpl
nmosaic.xpl
nmosaice.xpl
nmosprt.xpl
(with implicit
loading of libx2,
libxt, libxm, and
libmos)

0.0064
3.1723
0.0046
0.1685
0.0381
4.1104
3.1716
4.1105
1.5923

NCD Terminal Emulator
(ncdterm)

C term.xpl 0.2859

NCD Window Manager (ncdwm) C wm.xpl 0.2610
NFS daemon D nfsd.xpl 0.0222
PPP/SLIP daemon4 D pppd.xpl 0.0422
PPP/XRemote library4 L libppp.xpl 0.0157
Serial daemon D seriald.xpl 0.0080
Show Statistics (ncdstats) C stats.xpl 0.1336
Show Version, Show Memory,
and Show X Connections
(ncdshow)

C show.xpl 0.0216

SIE E sie.xpl 0.0249
SNMP D snmpd.xpl 0.0391
Test Network (ncdtestnet) C test.xpl 0.0081
Touch screen calibration
(touchscreen)

C touchscr.xpl 0.0154

X lib non-core functions L libx2.xpl 0.0362
XDM authentication L xdmauth.xpl 0.0591
XIE5 E xie.xpl 0.2374
Xinput E xinput.xpl 0.0686
XRemote4 E xremote.xpl 0.0645
Xremote print daemon D rprintd.xpl 0.0107
Xtest E xtest.xpl 0.0046

Table 3  Memory Used on Explora, Explora Pro, and Explora 400/450
Series NCs (Continued)

NCDware Feature Used Type Module Filename
Approx. Memory
Used by Loading

Module (MB)
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Xtrap E xtrap.xpl 0.0217

1 Java Virtual Machine requires all of the listed modules to operate.

2 The Motif Window Manager and video clients share a common library. Conse-
quently, loading more than one of them requires less memory than total
requirement of the components.

3 NCD Mosaic Browser requires one of the modules nmosaic.xpl,
nmosaice.xpl, or nmos128.xpl depending on the desired encryption level,
plus all of the remaining listed modules to operate. The browser loads
auplayer.xpl only if it encounters audio clips. It loads libprapi.xpl and
nmosprt.xpl only if the user selects the Print button. It loads jmosaic.xpl
only when Java runs.

4 The XRemote extension and PPP support share a common library. Conse-
quently, loading both requires less memory than total requirement of the
components.

5 Only the DIS portion of XIE is available for the Explora, Explora Pro, and
Explora 400/450 series NCs.

  Legend:   C=Local client, CS=Core server, D=Daemon, E=Extension, L=Library

Table 4  Memory Used on Explora 700 NCs

NCDware Feature Used Type Module Filename
Approx. Memory
Used by Loading

Module (MB)

Core X server CS Xncdxpt 3.6705
3270 client library L libbrx.xpt 0.0199
3270 terminal emulator (ncd3270) C tn3270.xpt 0.7784
3287 print emulator (ncd3287) C 3287.xpt 0.0678
Audio E audio.xpt 0.0862
Change Setup Parameters
(ncdsetup client)

C setup.xpt 0.1871

Change User Preferences (ncdpref
client)

C pref.xpt 0.1140

Clock client (ncdclock) C clock.xpt (with
implicit loading of
libXaw and
libXmu)

0.3696

CTerm library L libcterm.xpt 0.0236
Display PostScript (DPS) E dps.xpt 2.0370

Table 3  Memory Used on Explora, Explora Pro, and Explora 400/450
Series NCs (Continued)

NCDware Feature Used Type Module Filename
Approx. Memory
Used by Loading

Module (MB)
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Java Virtual Machine1 C audio.xpt
jagent.xpt
java.xpt
jawt.xpt
jjpeg.xpt
jmmedia.xpt
jnet.xpt

0.0862
0.1818
0.1672
1.6870
0.2392
0.1729
0.1746

Keymap Editor (keymap_editor) C keymap.xpt 0.2685
LAT protocol P latproto.xpt 0.0227
Local File Manager D filed.xpt 0.0211
Login New X Session (ncdlogin) C login.xpt 0.1223
Motif Window Manager2 (local
mwm)

C mwm.xpt (with
implicit loading of
libXm and libXt)

1.8738

Multi-buffering3 E multibuf.xpt 0.0130
NCD Mosaic Browser4 C audioplayer.xpt

browser.xpt
desktop.xpt
jmosaic.xpt
libprapi.xpt
nmos128.xpt
nmosaic.xpt
nmosaice.xpt
nmosprt.xpt
(with implicit
loading of libx2,
libxt, libxm, and
libmos)

0.0069
3.5020
0.0048
0.1712
0.0071
4.5060
3.4783
4.5061
1.6671

NCD Terminal Emulator
(ncdterm)

C term.xpt 0.3242

NCD Window Manager (ncdwm) C wm.xpt 0.2939
NFS daemon D nfsd.xpt 0.0223
OpenGL support E opengl.xpt 1.4411
PEX3 E pex.xpt 0.6108
PPP/SLIP daemon5 D pppd.xpt 0.0423
PPP/XRemote library5 L libppp.xpt 0.0158
Serial daemon D seriald.xpt 0.0081
Shared memory6 E mitshm.xpt 0.0038
Show Statistics (ncdstats) C stats.xpt 0.1465
Show Version, Show Memory,
and Show X Connections
(ncdshow)

C show.xpt 0.0199

SIE E sie.xpt 0.0252
SNMP D snmpd.xpt 0.0400
StarWorks support2 L starwrks.xpt 0.3586
SYNC extension E sync.xpt 0.0156

Table 4  Memory Used on Explora 700 NCs (Continued)

NCDware Feature Used Type Module Filename
Approx. Memory
Used by Loading

Module (MB)
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Test Network (ncdtestnet) C test.xpt 0.0083
Touch screen calibration
(touchscreen)

C touchscr.xpt 0.0175

Video decoder2, 6 (video) C video.xpt 0.7579
Video Player2, 6 (vp and
ncdsendvideo)

C vp.xpt 0.9651

X lib non-core functions L libx2.xpt 0.0382
XDM authentication L xdmauth.xpt 0.0580
XIE E xie.xpt 0.5469
Xinput E xinput.xpt 0.0702
XRemote5 E xremote.xpt 0.0642
Xremote print daemon D rprintd.xpt 0.0110
Xtest E xtest.xpt 0.0051
Xtrap E xtrap.xpt 0.0221

1 Java Virtual Machine requires all of the listed modules to operate.

2 The Motif Window Manager and video clients share a common library.
Consequently, loading more than one of them requires less memory than
total requirement of the components.

3 The module pex.xpt includes the multibuf.xpt module.

4 NCD Mosaic Browser requires one of the modules nmosaic.xpt,
nmosaice.xpt, or nmos128.xpt depending on the desired encryption level, plus
all of the remaining listed modules to operate. The browser loads auplayer.xpt
only if it encounters audio clips. It loads libprapi.xpt and nmosprt.xpt only if
the user selects the Print button. It loads jmosaic.xpt only when Java runs.

5 The XRemote extension and PPP support share a common library.
Consequently, loading both requires less memory than total requirement
of the components.

6 The video modules video.xpt and vp.xpt include the mitshm.xpt module.

  Legend:   C=Local client, CS=Core server, D=Daemon, E=Extension, L=Library

Table 5  Memory Used on HMX NCs

NCDware Feature Used Type
Module Filename

Approx. Memory
Used by Loading

Module (MB)

Core X server CS Xncdhmx 3.3023
3270 client library L libbrx.hmx 0.0199
3270 terminal emulator (ncd3270) C tn3270.hmx 0.7835
3287 print emulator (ncd3287) C 3287.hmx 0.0557
Audio E audio.hmx 0.0809
Change Setup Parameters
(ncdsetup client)

C setup.hmx 0.1942

Table 4  Memory Used on Explora 700 NCs (Continued)

NCDware Feature Used Type Module Filename
Approx. Memory
Used by Loading

Module (MB)
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Change User Preferences (ncdpref
client)

C pref.hmx 0.1194

Clock client (ncdclock) C clock.hmx (with
implicit loading of
libXaw and
libXmu)

0.3698

CTerm library L libcterm.hmx 0.0236
Display PostScript (DPS) E dps.hmx 2.0370
Java Virtual Machine1 C audio.xpt

jagent.xpt
java.xpt
jawt.xpt
jjpeg.xpt
jmmedia.xpt
jnet.xpt

0.0809
0.1818
0.1672
1.6870
0.2388
0.1729
0.1750

Keymap Editor (keymap_editor) C keymap.hmx 0.2729
LAT protocol P latproto.hmx 0.0299
Local File Manager D filed.hmx 0.0211
Login New X Session (ncdlogin) C login.hmx 0.1257
Motif Window Manager2 (local
mwm)

C mwm.hmx (with
implicit loading of
libXm and libXt)

1.8752

Multi-buffering3 E multibuf.hmx 0.0130
NCD Mosaic Browser4 C audioplayer.xpt

browser.xpt
desktop.xpt
jmosaic.xpt
libprapi.xpt
nmosaic.xpt
nmosaice.xpt
nmos128.xpt
nmosprt.xpt
(with implicit
loading of libx2,
libxt, libxm, and
libmos)

0.0069
4.1587
0.0047
0.1712
0.0071
4.1577
4.4981
4.4981
1.6671

NCD Terminal Emulator
(ncdterm)

C term.hmx 0.3138

NCD Window Manager (ncdwm) C wm.hmx 0.2828
NFS daemon D nfsd.hmx 0.0223
OpenGL support E opengl.hmx 1.4395
PEX3 E pex.hmx 0.6205
PPP/SLIP daemon5 D pppd.hmx 0.0465
PPP/XRemote library5 L libppp.hmx 0.0195
Serial daemon D seriald.hmx 0.0082
Shared memory6 E mitshm.hmx 0.0038

Table 5  Memory Used on HMX NCs (Continued)

NCDware Feature Used Type
Module Filename

Approx. Memory
Used by Loading

Module (MB)
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Show Statistics (ncdstats) C stats.hmx 0.1530
Show Version, Show Memory,
and Show X Connections
(ncdshow)

C show.hmx 0.0199

SIE E sie.hmx 0.0252
SNMP D snmpd.hmx 0.0400
StarWorks support2 L starwrks.hmx 0.3605
SYNC extension E sync.hmx 0.0156
Test Network (ncdtestnet) C test.hmx 0.0083
Touch screen calibration
(touchscreen)

C touchscr.hmx 0.0175

Video decoder2, 6 (video) C video.hmx 0.7565
Video Player2, 6 (vp and
ncdsendvideo)

C vp.hmx 0.9677

X lib non-core functions L libx2.hmx 0.0382
XDM authentication L xdmauth.hmx 0.0578
XIE E xie.hmx 0.5469
Xinput E xinput.hmx 0.0702
XRemote5 E xremote.hmx 0.0679
Xremote print daemon D rprintd.hmx 0.0113
Xtest E xtest.hmx 0.0051
Xtrap E xtrap.hmx 0.0221

1 Java Virtual Machine requires all of the listed modules to operate.

2 The Motif Window Manager and video clients share a common library.
Consequently, loading more than one of them requires less memory than
total requirement of the components.

3 The module pex.hmx includes the multibuf.hmx module.

4 NCD Mosaic Browser requires one of the modules nmosaic.hmx,
nmosaice.hmx, or nmos128.hmx depending on the desired encryption level,
plus all of the remaining listed modules to operate. The browser loads
auplayer.hmx only if it encounters audio clips. It loads libprapi.hmx and
nmosprt.hmx only if the user selects the Print button. It loads jmosaic.hmx
only when Java runs.

5 The XRemote extension and PPP support share a common library.
Consequently, loading both requires less memory than total requirement
of the components.

6 The video modules video.hmx and vp.hmx include the mitshm.hmx module.

  Legend:   C=Local client, CS=Core server, D=Daemon, E=Extension, L=Library

Table 5  Memory Used on HMX NCs (Continued)

NCDware Feature Used Type
Module Filename

Approx. Memory
Used by Loading

Module (MB)
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CD-ROM Content and Space Requirements
Table 6 lists the contents of the NCDware CD-ROM, including the
approximate required disk space in kilobytes (KB).

Table 6  NCDware Content

Description
Disk Space

 (Approx, KB)

Host-side binaries and bootp files

AIX 4229

HP-UX 6455

IRIX 5146

Motorola1 11783

Solaris 12980

Solaris (x86) 4084

SunOS 10652

Man pages 1102

Fonts

dps (DPS fonts and startup files) 3533

PEX (3D PEX fonts) 29

Speedo (scalable fonts for use with font server) 532

Type1 (Type 1 fonts for use with font server) 833

100dpi (100 dpi fonts) 3660

75dpi (75 dpi fonts) 3163

Xol (OpenWindows fonts) 312

dw100dpi (100 dpi fonts for DECwindows) 1060

dw75dpi (75 dpi fonts for DECwindows) 704

misc (miscellaneous fonts) 2417

java (fonts for use by Java and the browser) 4542

Font server 2

X Servers and Modules

Xncdhmx (uncompressed) 2520

Xncdhmx.bl (compressed) 1689

HMX modules 15533

Xncdxpl (uncompressed) 2221

Xncdxpl.bl (compressed) 1522

Explora, Explora Pro, Explora 400/450 modules 9921

Xncdxpt (uncompressed) 2363
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Binaries for NCD Utilities
Table 7 describes binaries provided for the SunOS, Solaris, AIX, HP-
UX, and IRIX platforms.

Xncdxpt.bl (compressed) 1603

Explora 700 modules 15524

Miscellaneous

Keysym database file (XkeysymDB) 4

Color database file (rgb.txt 18

Parameter documentation file (configd.doc) 339

SNMP database files (mib.my and mib.txt) 589

Configuration files (configs) 345

Java classes directory (java) 4267

Browser help files directory (help) 88

Time zone information (zoneinfo) 405

Users directory for the browser (users) 6
1 NCD has not tested and does not provide Technical Support for

Motorola binaries included in this release.

Table 7  Binary Files for NCD Utilities

Utility Description

General

bootpd
bootptab.ncd

BOOTP protocol files provided for SunOS, Solaris, HP-UX, IRIX, and AIX:
a bootpd(8) binary and an example bootptab file

makepsres Creates or updates PostScript resource files

ncdcfgcvt Converts configuration files from NCDware 2.4 format to NCDware 3.2.1 format

ncdcon Support utility for serial devices

ncddm NCD Display Manager daemon used for providing NFS and local client security and
establishing local client environment variables

ncdfloppy Manages DOS-compatible file system on floppy drive connected to an NCD network
computer

ncdlauncher Host-based application launcher

ncdloadprefs Loads a user preferences file into the network computer

Table 6  NCDware Content (Continued)

Description
Disk Space

 (Approx, KB)
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ncdloguser Support utility used by NCD Display Manager

ncdquery Lists the values of selected SNMP variables for a network computer

ncdreset Remotely resets a network computer

ncdrestartwm Restarts the local window managers

ncdrunterm Terminal emulator client without security

ncdrunwm Starts local window managers

ncdsendvideo Starts the Video Player

ncdwm Provides a host-based version of the NCD Window Manager

resize Sets TERMCAP and network computer settings to the current window size

xdm X Display Manager with support for XDMCP

xinitremote Startup script for XRemote

Xremote Helper program for XRemote

Fonts

mkfdir Utility for adding Adobe outline fonts to the fonts.scale file

ncdbdftopcf Converts fonts from Bitmap Distribution Format (BDF) to Portable Compiled
Format (PCF)

ncdfs The NCD font server

ncdfsinfo Provides information about the font server

ncdfslsfonts Displays the X server font list for the font server

ncdfstobdf Reads fonts from a font server and creates a BDF file

ncdmkfontdir Creates a fonts.dir file from a directory of font files

ncdshowfont Displays data about fonts for the font server

FLEXlm License Management

lmgrd License manager daemon

lmutil Utilities

ncdlicense Client for license negotiation

ncdlmd Vendor daemon

Table 7  Binary Files for NCD Utilities (Continued)

Utility Description
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Printing

ascii.print
dj.print
dj.prologue
lj.print
lj.prologue
lw.print
ncdcanon
ncdchr
ncdecho

Support utilities used by ncdlp

ncdlp Sends a file to a printer connected to an NCD network computer; for use with ASCII,
HP DeskJet, HP LaserJet, or PostScript printers

ncdlprv Support utility used by ncdlp

ncdnetcon Support utility used by ncdprint

ncdpaginate Support utility used by ncdlp

ncdprint Sends a file to a printer connected to an NCD network computer; for use with
printers other than those supported by ncdlp

ncdpsrv Support utility used by ncdlp

ncdreadn
ncdtxt2ps

Support utilities used by ncdlp

ncdxrcon Support utility used by ncdprint

Table 7  Binary Files for NCD Utilities (Continued)

Utility Description
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Quick Start PCMCIA Cards
Quick Start PCMCIA cards contain X server and support files for NCD
network computers. Quick Start PCMCIA cards are available in the
4 MB size for Explora, Explora Pro, and Explora 400/450 series
network computers. The 12 MB Quick Start cards are available for all
NCD network computers.

Quick Start PCMCIA cards are shipped write-protected. You cannot
save configuration changes for the next reboot when the card is write
protected. To write-enable the card, move the write-protect switch to
the off position.

Caution

Do not change a PCMCIA card’s write-protection without
rebooting your network computer or you will corrupt the
card and experience unpredictable results. If you want to
change a card’s write-protection, NCD recommends that
you bring down your network computer, set the switch to
the desired write-protection, and reboot your network
computer.
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The 4 MB card contains a subset of NCDware, including modules
needed for XRemote and such basic operations as NCD Window
Manager, NCD Terminal Emulator, Change Setup Parameters, and
login services. (See Figure 1.)

Xncdxpl.bl (X server file)

modsxpl (modules directory)

fonts (fonts directory)

rgb.txt (color definitions file)
ncd_std (configuration file)
ncd_std.stp (file used to write changes to ncd_std)

Figure 1  Organization of the 4 MB Quick Start PCMCIA Card

audio.xpl
filed.xpl
latproto.xpl
libcterm.xpl
libppp.xpl
login.xpl
pppd.xpl
pref.xpl
rprintd.xpl
seriald.xpl
setup.xpl

show.xpl
sie.xpl
snmpd.xpl
stats.xpl
term.xpl
test.xpl
wm.xpl
xdmauth.xpl
xremote.xpl
xtest.xpl
xtrap.xpl

*.snf.Z
fonts.dir
fonts.alias

Note that you should not remove
the filed  module from the
PCMCIA card. If you do, you
cannot access the card without
booting the network computer
from the network or putting it into
another network computer that
boots from the network.

XKeysymDB (keysym database file)



X Servers in This Release

22 NCDware 5.0.129 Release Notes

The 12 MB card includes the same modules as the 4 MB card plus
modules for support of Java and the NCD Mosaic Browser on all NCs
and MPEG video for the Explora 700 and HMX NCs. (See Figure 2.)

For more information about installing and using a Quick Start card,
see Installing Your PCMCIA Card and the NCDware System
Administrator’s Guide for UNIX Systems.

For information about using the NCD Mosaic Browser on the Quick
Start card, see “Using the Browser on a Quick Start Card” on page 26.

Xncdhmx.bl, Xncdxpl.bl, or Xncdxpt.bl (X server file)

modshmx, modsxpl, or modsxpt (modules directory)

rgb.txt (color definitions file)
ncd_std (configuration file)
ncd_std.stp (file used to write changes to ncd_std)

The file extension is either
.hmx , .xpl , or .xpt
depending on which card
you have.

3287.xxx
audio.xxx
auplayer.xxx
browser.xxx
desktop.xxx
filed.xxx
jagent.xxx
java.xxx
jawt.xxx
jjpeg.xxx
jmmedia.xxx
jmosaic.xxx
jnet.xxx
keymap.xxx
latproto.xxx
libbrx.xxx
libcterm.xxx
libmos.xxx
libppp.xxx
libprapi.xxx
libx2.xxx
libxm.xxx
libxt.xxx
login.xxx

mitshm.xxx
nfsd.xxx
nmosaice.xxx
nmosprt.xxx
pppd.xxx
pref.xxx
rprintd.xxx
seriald.xxx
setup.xxx
show.xxx
sie.xxx
snmpd.xxx
starwrks.xxx
stats.xxx
term.xxx
test.xxx
tn3270.xxx
video.xxx
vp.xxx
wm.xxx
xdmauth.xxx
xremote.xxx
xtest.xxx
xtrap.xxx

Note that you should not remove
the filed  module from the
PCMCIA card. If you do, you
cannot access the card without
booting the network computer
from the network or putting it into
another network computer that
boots from the network.

The video modules are available
on the 12 MB cards for the
Explora 700 (.xpt ) and HMX
family (.hmx ); they are not
available for the Explora,
Explora Pro, Explora 400/450
series.

java (Java classes directory)
help (HTML files for Browser)

XKeysymDB (keysym database file)

fonts (fonts directory)
Directories for 100dpi, 75dpi, and misc
fonts each include: *.snf.Z, fonts.dir, and
fonts.alias

Figure 2  Organization of the 12 MB Quick Start PCMCIA Card
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Changes and New Features
The following sections describe new features and changes in
NCDware 5.0.129.

Explora 400/450 Series
NCDware 5.0.129 provides software support for the Explora 400/450
series network computers. These NCs consist of a circuit board in one
of two bases, a monitor, a mouse, and a keyboard. You can purchase
the NC alone or with a monitor. The two bases are:

❏ The space-saver base, with an ergonomic design with a small
footprint

❏ The monitor support base, which supports the weight of a color
monitor

The Explora 400/450 NCs are advanced network computers that
include the following features:

❏ VGA/SVGA/XGA/SXGA monitor support
❏ PS/2 mouse support
❏ Multiple keyboard choices
❏ Serial (RS-232 C) port
❏ Parallel port
❏ Externally accessible PCMCIA card slot
❏ Audio output (except on the Explora 450 with the optional thin

coaxial Ethernet connection)
❏ ENERGY STAR compliance for energy efficiency
See Installing Your Explora 400/450 Series Network Computer for more
information.

Table 8 compares the features of the Explora 400 and Explora 450.

Table 8 Explora 400/450 Feature Comparison

Feature Explora 400 Explora 450

CPU PowerPC 403GA, 33 MHz PowerPC 403GCX, 66 MHz

Memory 8 MB standard, 128 MB maximum, fast-
page mode

8 MB standard, 128 MB maximum,
EDO-mode

Graphics S3 TRIO64V2/DX, 1 MB EDO DRAM,
used as a frame buffer, 1152x900
maximum

S3 TRIO64V2/DX, 2 MB EDO DRAM,
used as a frame buffer, 1280x1024
maximum

Networking Twisted-pair 10BaseT Ethernet Twisted-pair 10/100BaseT Ethernet
standard and optional thin coax
Ethernet in place of audio output
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Explora 700
NCDware 5.0.129 provides software support for the Explora 700
network computer (NC). This NC consists of a circuit board in a base,
a monitor, a mouse, and a keyboard. You can purchase the NC alone
or with a monitor. The Explora 700 NC is an advanced network
computer that includes the following features:

❏ MIPS R4700, 150 MHz CPU

❏ Standard memory of 8 MB memory can be increased to a
maximum of 256 MB

❏ Twisted pair 10/100BaseT Ethernet
❏ Thin coaxial Ethernet
❏ VGA/SVGA/XGA/SXGA monitor support
❏ PS/2 mouse support
❏ Multiple keyboard choices
❏ Serial (RS-232 C) port
❏ Parallel port
❏ Externally accessible PCMCIA card socket
❏ Audio output
❏ ENERGY STAR compliance for energy efficiency
See Installing Your Explora 700 Network Computer for more
information.

Java Virtual Machine and Applet Viewer
Java Virtual Machine (JVM) 1.0.2 is a network programming
environment for creating and running embedded Java applets and
standalone Java applications.

JVM requires a license for each network computer. Contact your sales
representative if you need to purchase licenses.

The user programs included with the JVM are:

❏ The java program, which allows users to run complete Java
applications.

❏ The appletviewer program, which is a Java application that allows
you to run applets in an applet viewer window. Although
appletviewer allows you to run applets embedded in an HTML
page, it does not display any of the surrounding HTML data.

Note The appletviewer program does not provide print
capability; this must be provided by the applet or
standalone Java application.
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You can start java and appletviewer from the Console’s Utilities
menu. You can run applets and Java applications that reside on the
local network or the World Wide Web.

See the NCDware User’s Guide and the NCDware System
Administrator’s Guide for UNIX Systems for more information.

NCD Mosaic Browser
NCD Mosaic Browser is an Internet browser that you can use to view
sites on the World Wide Web (Web) and other Internet resources,
provided that you have an Internet connection. The browser is based
on Version 3.2 of Spyglass Mosaic and supports JavaScript Version
1.1. You can print from the browser to a local printer attached to
your network computer and to remote printers. You start the
browser from the Console’s Utilities menu.

The browser requires a license for each network computer. Contact
your sales representative if you need to purchase licenses.

NCD Mosaic Browser does not support background audio.
Background audio is the music used by some Web sites.

The browser supports Java applets that require basic authentication
as supported by JVM 1.1.0.

Note NCD Mosaic Browser might attempt to use fonts,
such as Palatino and ITC, that are not supplied by
NCD. If you want to use these fonts, you must add
them to your font path.

See the NCDware User’s Guide and the NCDware System
Administrator’s Guide for UNIX Systems for more information.

Decreasing Start Time for the Browser
To decrease the time it takes for the NCD Mosaic Browser to start, use
the modules-load-policy parameter to add the browser modules to
your configuration file so that the browser loads automatically at
boot time. (Note that this slightly increases the time it takes for the
NC to boot.)

The required browser modules are:

modules-load-policy = {
{“libx2” at-boot}
{“libxt” at-boot}
{“libxm” at-boot}
{“libmos” at-boot}
{“desktop” at-boot}
{“browser” at-boot}
{“nmosaic” at-boot}}
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Note You must add all the modules listed above, in the
order listed, to your configuration file for the
browser to load automatically at boot time.

Use nmosaic to run the browser without encryption. Use nmosaice to
run the browser with 40-bit encryption. Domestic USA users can also
use nmos128 to provide a higher level, 128-bit, encryption.

Using the Browser on a Quick Start Card
If you are using the NCD Mosaic Browser from a Quick Start PCMCIA
card, the functionality differs from that of the browser downloaded
from a network host. The differences depend on the external network
services available to the browser.

In environments in which the NCD Display Manager (ncddm) and
NFS (Network File System) are operating on a host accessible to the
network computer:

❏ You cannot change the browser preference files easily because the
card is write-protected

❏ You can use only the 40-bit encrypted version of the browser
(nmosaice). If you set Setup ⇒ Change Setup Parameters ⇒
Browser ⇒ Browser Module to select any other than nmosaice,
the browser does not load.

In environments in which no host is available to provide services, the
differences are greater:

❏ Without NFS file services, browser function is limited:
— The user cannot view the source for HTML files
— The Save As and Open Local commands cannot list either files

in a directory or directories in a directory. Therefore, the user
cannot navigate through a directory tree by clicking on
directory names.

— Helpers cannot be used
— Preference files cannot be written

❏ If you need additional fonts, you must add them to the Quick
Start card

❏ You cannot save a hotlist or history file from session to session
❏ The .nmosaic-prefs and the .nmosaic-viewers-default files are not

contained on the card, so the parameters normally contained in
them cannot be changed

❏ You cannot play video or audio links because they require
temporary storage for downloading data prior to playback
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NCD Display Manager
The NCD Display Manager is a host-based daemon that provides
local clients with information about the user currently logged in. The
NCD Display Manager and a helper utility, ncdloguser, are installed
and started on the login host when you use ncdinstall to install
NCDware and select NFS as the file access method. ncdloguser records
information in a log file for use by NCD Display Manager. You must
manually enable the NCD Display Manager in the network
computer’s Setup menus.

If the NCD Display Manager is enabled on the network computer, the
network computer queries the host-based daemon for the user’s
name (USER), home directory (HOME), and the UID and GID. The
login user’s home directory is added to the network computer’s file
service table, but you must arrange to export it from the host.

See the NCDware System Administrator’s Guide for UNIX Systems for
more information.

Light Pen
The Explora, Explora Pro, and Explora 400/450 series of network
computers support the FTG Data Systems PXL-795 light pen.

You can use a light pen in place of a mouse or you can use it in
conjunction with a mouse.

A light pen must detect light in order to determine its position on a
display. As a result, you cannot use your light pen in areas of the
display that are very dim or completely black unless you enable the
light pen’s blue flood feature.

See the NCDware User’s Guide for more information.

Document Imaging Subset (DIS)
The DIS portion of XIE is supported on the Explora, Explora Pro, and
Explora 400/450 series network computers. DIS provides basic
imaging functions such as rotation, scaling, and compression and
decompression of images. It replaces SIE (Simple Imaging Extension)
provided in earlier NCDware releases for the Explora and Explora
Pro.

Full XIE capability is supported on the HMX and Explora 700
network computers.

Wireless Support
A wireless network consists of wireless Explora network computers
and Proxim wireless LAN Access Points attached to an Ethernet
network. Network computers can use Access Points to boot and to
communicate with hosts on the Ethernet network.
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Wireless network computers have the same access to network
application software, printers, e-mail, and other network services as
do network computers connected to the network through Ethernet
cabling.

Explora 400/450 series network computers can be used on a wireless
network. Each wireless NC must have a Proxim RangeLAN2 7200 or
7400 wireless LAN adapter installed. The LAN adapter is a PCMCIA
card (PC card) with an antenna and is an optional item that you can
purchase from Proxim, Inc. The LAN adapter functions as an
Ethernet network interface without a cable.

For wireless use, the NC must have Boot Monitor 2.9 or later, which
includes the wireless commands and other features for wireless use.

There must be at least one Proxim Access Point connected to an
Ethernet network. Network computers must have IP addresses on
the same subnet as the Access Point. Therefore, each subnet involved
in the wireless network must have its own Access Point(s).

NCDware 5.0.129 must be installed on an Ethernet network host that
is accessible by the wireless network computers.

See the NCDware System Administrator’s Guide for UNIX Systems for
more information.

PEX
NCDware 5.0.129 is the last release of NCDware to support PEX. PEX
is a 3D graphics extension to the X Window System protocol. HMX
and Explora 700 models of NCD network computers support PEX
options.

NCDware provides OpenGL as a replacement for PEX. The OpenGL
graphics extension included in NCDware provides support needed
to run OpenGL-based graphics programs with output to the HMX
and Explora 700 network computer models.

Remote Configuration File Updates and Parameter Changes
The following sections describe:

❏ New remote configuration parameters
❏ Revised remote configuration parameters
❏ An obsolete remote configuration parameter
The Remote Configuration Parameter Quick Reference describes the
remote configuration parameters in detail.
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New Remote Configuration Parameters
This release of NCDware includes the new remote configuration
parameters listed in Table 9.

Table 9  New Remote Configuration Parameters

Parameter Name Description

boot-prom-update-file Updates the Boot Monitor when the network computer is
rebooted.

browser-auto-load-images Specifies if the NCD Mosaic Browser will automatically load
Web pages.

browser-cache-size Specifies maximum size of the memory cache in kilobytes.

browser-environment Specifies the variables for the NCD Mosaic Browser.

browser-ftp-proxy-host Specifies the host that runs an FTP proxy server.

browser-ftp-proxy-host-port Specifies the TCP/IP port on which the FTP proxy server
listens for connections.

browser-ftp-proxy-overrides Specifies the FTP proxy domains that avoid or override the
proxy host.

browser-gopher-proxy-host Specifies the host that runs a gopher proxy server.

browser-gopher-proxy-host-port Specifies the TCP/IP port on which the gopher proxy server
listens for connections.

browser-gopher-proxy-overrides Specifies the gopher proxy domains that avoid or override the
proxy host.

browser-home-page Specifies the home page loaded by the NCD Mosaic Browser
when it starts.

browser-http-proxy-host Specifies the host that runs an HTTP proxy server.

browser-http-proxy-host-port Specifies the TCP/IP port on which the HTTP proxy server
listens for connections.

browser-http-proxy-overrides Specifies the HTTP proxy domains that avoid or override the
proxy host.

browser-java-applets Specifies that Java applets are executed when included in Web
contents.

browser-jscript-active Specifies that Jscript/JavaScript routines are executed when
Web contents are loaded.

browser-max-connections Specifies the maximum number of TCP/IP connections that
the NCD Mosaic Browser can open concurrently.

browser-module Specifies the NCD Mosaic Browser module that is loaded.

browser-print-table Specifies the printers available for printing from the NCD
Mosaic Browser. By default, this is an empty table.
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browser-show-tool-bar Specifies that the NCD Mosaic Browser toolbar is displayed.

browser-smtp-email-server Specifies the SMTP electronic mail server host.

browser-socks-host Specifies the host that runs the SOCKS daemon, which
approves requests from outside the local network for a
network resource.

browser-socks-port Specifies the TCP/IP port on which the SOCKS daemon listens
for connections.

exec-command-menu Specifies the local commands in the default root window
menu.

exec-user-access-control Specifies that requests to start local commands with a remote
shell command are restricted to the user logged into the
terminal. Takes effect only if the NCD Display Manager and
XDM are running on the login host.

java-appletviewer-command Specifies the Java command line for starting appletviewer.

java-cache-class-file Specifies that the Java classes shipped with NCDware are
loaded and cached in memory.

java-directory Specifies the pathname of the directory where Java class and
properties files are located.

login-ncddm-enabled Specifies if the network computer should query the NCD
Display Manager (ncddm) on the login host for the username,
home directory, and NFS GID and UID of the user logged in on
the network computer. The login host must be running a login
service shell such as XDM.

login-ncddm-tcp-port Specifies the TCP port on which the NCD Display Manager
(ncddm) listens for requests for user information.

net-domain-channel Specifies the domain number of a wireless Explora 400/450
network computer.

net-minimum-data-buffers Specifies the minimum number of pre-allocated network
buffers. Normally, network buffers are allocated as needed.

net-roaming-condition Specifies the speed at which a wireless Explora 400/450
network computer roams from one Access Point to another.

pref-environment Specifies environment variables for local clients.

pref-opengl-debug Specifies that memory checks and debug statements are
enabled.

tcp-default-mss-for-non-local Specifies the segment sizes to be used when communicating
with non-local hosts.

tcp-name-cache-ignore-case Specifies that case is ignored when searching for a name in the
local name cache.

Table 9  New Remote Configuration Parameters (Continued)
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Revised Remote Configuration Parameters
Table 10 summarizes changes to remote configuration parameters
from NCDware 4.1 to NCDware 5.0.

Obsolete Remote Configuration Parameter
The ncd3270-enable-3270-emulation parameter is no longer available.

Changes in the Console
The following changes have been made in the Console:

❏ Numerous new parameters are accessible through the Setup
menus. See “Remote Configuration File Updates and Parameter
Changes” on page 28 for a list of new parameters. For their
Console location, see the Remote Configuration Parameter Quick
Reference.

❏ The Utilities menu contains the following new items:
— Utilities ⇒ Start Local Command displays a window where

you can enter a command line for a local client or local
command.

pwireless-interface-table Lists Token-Ring status and parameter values for an 802.5
interface (read-only). Applies to Explora 400/450 network
computers only.

pwireless-statistics-table Lists wireless statistics (read-only). Applies to Explora 400/450
network computers only.

xserver-enable-local-lightpen-
blue-flood

Enhances the lightpen’s ability to distinguish light from dark.
For Explora, Explora Pro, Explora 400/450 network computers
only.

time-zone Specifies the time zone file (in /usr/lib/X11/ncd/zoneinfo)
corresponding to the location of the network computer.

Table 10  Revised Remote Configuration Parameters

Parameter Name Description of Changes

modules-load-policy The SNMP name has changed to ncdModulesLoadPolicy. The
SNMP path for the index field has changed to
ncdModulesLoadPolicyTable 1. The SNMP path for the name
field has changed to ncdModulesLoadPolicyTable 2. The
SNMP path for the policy field has changed to
ncdModulesLoadPolicyTable 3.

time-offset-from-gmt Specifies the offset from Greenwich Mean Time (GMT) in
minutes instead of hours.

Table 9  New Remote Configuration Parameters (Continued)
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— Utilities ⇒ Start NCD Mosaic Browser starts the NCD Mosaic
Browser.

— Utilities ⇒ Start Java Applet displays a window where you
can type a URL for a Java applet.

❏ The Statistics menu contains the new item Statistics ⇒ Show
Wireless that displays information about the wireless Access
Point. This item appears on Explora, Explora Pro, and Explora
400/450 network computers only.

Recent Boot Monitor Changes
This section describes recent changes in Boot Monitor firmware,
including:

❏ Current Boot Monitor versions for the HMX family of network
computers (HMX, HMXpro, and HMXpro24), and the Explora,
Explora Pro, Explora 400/450 series, and Explora 700 network
computers

❏ Updating the Boot Monitor over the network for Explora 400/450
series and Explora 700 network computers

Boot Monitor 2.8
Boot Monitor 2.8 is the current version for the HMX family of
network computers (HMX, HMXpro, and HMXpro24), and the
Explora and Explora Pro network computers.

Boot Monitor 2.8.3 corrects a RAMDAC problem related to the video
monitor that existed in version 2.8.2. It adjusts the RAMDAC clocks to
correct the problem. The RAMDAC problem occurred on HMX
network computers only.

Boot Monitor 2.9
Boot Monitor 2.9 is the current version for Explora 400/450 series
and Explora 700 network computers. Boot Monitor 2.9 includes the
features of previous versions in addition to:

❏ Support for the Explora 400/450 series and Explora 700 hardware
platforms

❏ Support for the wireless network computer
❏ Determining the best resolution for the monitor and setting its

resolution
❏ Support for Boot Monitor updates over the network
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Updating the Boot Monitor
On Explora 400/450 series and Explora 700 network computers you
can download an updated Boot Monitor from the host using a
remote configuration file.

Caution

Do not turn off power to the network computer while the
Boot Monitor is being updated. If the update process is
interrupted before the new Boot Monitor is written to
PROM, the Boot Monitor will not have the settings neces-
sary to operate the NC. In that case, you would have to
return the base to the factory for rework.

For this reason, NCD recommends that you promptly
reboot NCs as soon as you have configured them for Boot
Monitor update and that you not configure NCs for Boot
Monitor update when power outages are likely to occur.

To download a new Boot Monitor version, set the boot-prom-update-
file parameter to the absolute pathname of a file that contains a new
Boot Monitor image. Such files are available from NCD whenever the
Boot Monitor is updated. When it boots, the NC attempts to update
its boot PROM with the new image. The update process begins as
soon as the NC receives and verifies the entire update file.

If the X server detects that the Boot Monitor in the NC is an earlier
version, it downloads the new version. If the NC’s Boot Monitor is
the same or a later version, no action is taken. The update process
takes about 15 seconds.
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Problems Fixed Since NCDware 4.1
Since the release of NCDware 4.1, the known problems described in
this section have been fixed. Problem numbers listed are the numbers
by which the problems were identified in NCD’s problem database.

Table 11  Summary of Problem Solutions Since NCDware 4.1

Problem
Number

Description of Solution

4954 There is now a message indicating that parameters were successfully saved to NVRAM
when you select Save to NVRAM  from the File menu in Setup ⇒ Change Setup
Parameters.

7447 A problem that resulted in memory depletion when running the Video Player in loop
mode has been fixed.

7601 The Keyboard hide box’s Enable Keyboard Autorepeat  toggle, which is enabled
by default, can now be disabled.

7674 Running ncdsendvideo on an x86 host with Solaris no longer results in a network
computer panic.

7678 The item Restore Factory Defaults  in the File menu has been changed to
Restore Defaults . This item restores the network computer to the boot-time
configuration.
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Known Problems
This section describes:

❏ Features of NCDware 5.0.129 that are not fully functional or may
not work exactly as described in NCDware manuals

❏ Limitations in NCDware 5.0.129
❏ Compatibility issues with certain host systems and applications
Please contact NCD Technical Support if you need assistance with
any of these problems. Refer to “In Case of Trouble” on page 42 for
information on how to contact NCD Technical Support.

If there is a problem number from NCD’s problem database, that
number is included in the problem description.

Table 12  Summary of Problems

Problem
Number

Description of Problem

Audio

9418 You will hear popping sounds when you start or stop an audio file on Explora 700
network computers.

Boot Monitor and NVRAM

If you have run a new X server, and later decide to run an X server from a previous
release, reset NVRAM to its default settings. At the Boot Monitor prompt (>), load
defaults by using the l command, followed by the s command (save), and q
command (quit).

9504 The boot monitor un command requires the file extension .dump, which is not
consistent with the existing up command. For example:
% un /mydir/crash.dump ncdip hostip gateway

Booting the Network Computer

9341 If you select NFS as the file service during installation, the ncdinstall utility does not
configure the TFTP file service.

9363 The Explora 400/450 series network computers require the NCDware 5.0 version of
Xncdxpl. If you attempt by mistake to boot your Explora 400/450 series network
computer using a previous version of Xncdxpl, the NC displays a misleading message,
and does not boot: Starting server, please wait...
You must reboot using the NCDware 5.0 server version.
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Configuration

4865 When configuring a network computer to boot via NFS in the NVRAM Setup menus,
you must specify the boot directory with a trailing slash (/). Otherwise, the network
computer does not boot properly. For example, if the boot directory is /tftpboot, specify
it as /tftpboot/ in the Setup menu.

In some cases, the network computer does not boot correctly if you insert a leading
space in the X server filename.

9453 NCDware sets the lat-service-directory-max-size parameter to zero in the
configuration file, but zero is not a valid value for this parameter. When rebooting,
NCDware displays a message stating that this is not a valid value.

To correct this situation, either remove the lat-service-directory-max-size parameter
from your configuration file, or set the parameter to a value between 25 and 100.

Console

The Clear All button in Statistics ⇒ Show Statistics does not clear all statistical
parameters. Parameters for which the values are not cleared are:

Table 12  Summary of Problems (Continued)

Problem
Number

Description of Problem

font-object-count
font-objects-currently-in-use
font-total-fonts-loaded
icmp-destination-unreachables-received
icmp-destination-unreachables-transmitted
icmp-packets-received
icmp-packets-transmitted
ip-packet-reassembly-timeout
ip-packet-transmission-requests
ip-packets-received
ip-packets-received-and-delivered
ip-packets-received-with-unknown-protocols
net-available-buffers
net-connection-control-structure-buffers
net-connection-name-buffers
net-interface-address-buffers
net-number-of-interfaces
net-packet-data-buffers
net-protocol-control-structure-buffers
net-reserved-data-buffers
net-total-buffers
snmp-get-requests-received
snmp-get-responses-transmitted
snmp-packets-received

snmp-packets-transmitted
tcp-ack-only-packets-transmitted
tcp-ack-packets-received
tcp-established-connections
tcp-maximum-retransmission-time
tcp-minimum-retransmission-time
tcp-packets-received
tcp-packets-transmitted
tcp-passive-connects-attempts
tcpip-name-cache-hits
tcpip-name-no-server-responses
tcpip-name-requests
tcpip-name-server-hits
tcpip-name-system-errors
tftp-ack-packets-transmitted
tftp-data-packets-received
tftp-file-read-requests-transmitted
tftp-file-write-requests-transmitted
tftp-no-file-error-responses-received
tftp-packets-retransmitted
udp-packets-received
udp-packets-received-with-unknown-port
udp-packets-transmitted



Known Problems

NCDware 5.0.129 Release Notes 37

Cut and Paste Between Clients

In NCD local clients, the default selection area is PRIMARY, but in OpenWindows, the
selection area is CLIPBOARD. You must change PRIMARY to CLIPBOARD before
attempting to cut and paste, using a resource similar to the following:

*stringSelections: CLIPBOARD

After this change, all local clients use CLIPBOARD instead of PRIMARY for all text
selections.

2076 Key translations that specify multiple cut-and-paste selections or multiple cut buffers
(such as translations for transferring data between local clients and OpenWindows
clients) are not supported in local clients.

Floppy Drive Support

9419/9448 The Explora 400/450 series and Explora 700 network computers might experience an
occasional floppy drive failure. The NCD Console displays a message like the
following when trying to run ncdfloppy:

OPEN failed: Unable to find floppy device.
Unable to initialize floppy drive.

If you encounter this message, run ncdfloppy again.

Fonts and Font Server

If you use terminal emulation applications that make extensive use of line-drawing
characters, make sure that the dw100dpi or dw75dpi font directory appears at the
beginning of the network computer’s font path. Otherwise, you may have trouble with
both line-drawing characters and other special characters.

Installation

9038 The NCDware CD insert contains installation procedures for installing NCDware on
UNIX and WinCenter hosts. For information about manual installation, contact NCD
Technical Support.

9209 The ncdinstall utility aborts if it gets a bad link with this error message:
test: argument expected .

Java Virtual Machine

8556 You need a minimum of 16 MB of memory in your NC to run the NCD Mosaic Browser
and a minimum of 16 MB of memory to run Java. If you want to run both the browser
and Java together, you need 24 MB of memory. However, NCD recommends 32 MB of
memory in your NC for running the browser and Java together.

Table 12  Summary of Problems (Continued)

Problem
Number

Description of Problem
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9298 You may need to increase the net-minimum-data-buffers if the NCD Console displays
messages like the following when trying to run Java Virtual Machine:

TERM-F-DISPLAY: Can't open the display connection.

UI-F-NOCONN: Unable to connect to display ":.0." Possible low
memory condition.

Local Printing

Local printing from an NCD network computer only prints ASCII or PostScript files.
Contact NCD Technical Support if you need to print PCL format files.

When the printer finishes with a job, the message Closed Session should appear in
the Console Messages hide box. If this message does not appear, you must explicitly
close the connection using the Abort Serial Line command(s) in the Console
menu.

Memory

7400 Running local video decoding options on an HMXpro with 8 MB of memory might
cause memory problems. NCD recommends that you have 12 MB of memory in your
HMXpro if you want to run local decoding options.

NCD Mosaic Browser

8932 To decrease the start time for the NCD Mosaic Browser, use the modules-load-policy
parameter to add browser modules to your configuration file so that the modules load
automatically at boot time. See “Decreasing Start Time for the Browser” on page 25 for
more information.

Use nmosaic to run the browser without encryption. Use nmosaice or nmos128 (domestic
USA customers only) to run the browser with encryption.

8989 The left margin on some web pages may increase incorrectly because of problems with
BLOCKQUOTE or H4 tags.

9127 Use of the Home and End keys to move to the start and end of a document may not
work as expected. If the keyboard focus is on a web page, Home and End may work. If
they do not work, Shift-Home and Shift-End may work instead. If the keyboard focus
is in a text-entry field or on any other portion of the browser, the Home and End keys
do not work at all.

9298 You may need to increase the net-minimum-data-buffers if the NCD Console displays
messages like the following when trying to run NCD Mosaic Browser:

TERM-F-DISPLAY: Can't open the display connection.

UI-F-NOCONN: Unable to connect to display ":.0." Possible low
memory condition.

Table 12  Summary of Problems (Continued)

Problem
Number

Description of Problem
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9342 The Common Desktop Environment (CDE) sets a resource so that text displays white.
With the NCD Mosaic Browser, certain pages such as the start page and help pages
have a white background. As a result, the text on these pages does not display.

To avoid this problem, set your screen background to any color other than white using
Setup ⇒ Change User Preferences.

9444 NCD Mosaic Browser might attempt to use fonts, such as Palatino and ITC, that are not
supplied by NCD. If you want to use these fonts, you must add them to your font path.

9445 NCD Mosaic Browser does not display in-line items in the Graphics Interchange
Format (GIF) in the proper vertical position.

9446 NCD Mosaic Browser does not support background audio. Background audio is the
music used by some Web sites.

NCDware Manuals

In Using the 3270 Terminal Emulator, on page 4-24 under “Applying Keymaps to Windows
on the Desktop,” the manual says: “For a terminal emulator with a special class name,
type the class name.”

Entering a special class name (instance name) has no effect. If you enter the ncd3270
class name, the current keymap is applied to all open 3270 emulator windows. If you
enter the NCDterm class name, the current keymap is applied to all open VT320
emulator windows. (In other contexts, the instance name overrides the class name.)

6138 In Using the 3270 Terminal Emulator, the -trans command-line option and translations
resource, which are documented in the man page and on page 4-24, are for specifying
Xt-style translations directly (instead of loading them from a file, as is stated incorrectly
in the documentation).

For example, to use the -trans option:
rsh ncdu374 tn3270 -trans “<Key>KP_Enter:Enter()”

or
rsh ncdu374 tn3270 -trans “Ctrl<Key>4:onecharacter(0X4A)”

Do not use multiple translations or include spaces in the translations.
Use the -transfile filename command-line option to load a translation file.

In the NCDware CD insert on p. 12, two symbolic links are omitted from the list of
items installed by ncdinstall. They are a link (/tftpboot/help) to the help directory
containing the browser help files and a link (/tftpboot/java) to the java directory
containing the Java classes. For a list of the directories and X servers installed by the
installation script, see “Software Installation” on page 6 of this document. For more
information about the Java and browser software, see the System Administrator’s
Guide.

9341 The NCDware CD insert does not say explicitly that if you select to install NFS for file
service, ncdinstall does not configure TFTP for file service.

Table 12  Summary of Problems (Continued)

Problem
Number

Description of Problem
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PCMCIA Cards

9438 Quick Start PCMCIA cards execute the reclaim command any time it is issued. This
occurs even if the card is write-protected.

9459 Quick Start PCMCIA cards are shipped write-protected. To write-enable the card,
move the write-protect switch to the off position. Do not change the card’s write-
protection without rebooting your network computer or you will corrupt the card and
experience unpredictable results.

If you want to change a card’s write-protection, NCD recommends that you bring
down your network computer, set the switch to the desired write-protection, and
reboot your network computer.

9462 Quick Start PCMCIA cards execute the mkdir command any time it is issued. This
occurs even if the card is write-protected.

Video

7385/7681 ncdsendvideo may abort when fast-forwarding with the CompCore video fast MPEG
decoder turned on.

7449 When using the CompCore video fast MPEG decoder to play very small video clips
that do not include an audio portion, replaying the video might skip some frames.

Window Managers and Application Launchers

The NCD Window Manager ignores the WM_NORMAL_HINTS maximum size
property when it initially sizes the window.

4939 The resources menuFont and Font cannot be used to specify different fonts for the title
and menus provided by ncdlauncher. If both are specified, the font specified by
menuFont is used for both the menus and the title.

6074 The line continuation character (a backslash at the end of the line) does not work in
.launchrc files. You can work around this problem by using a single long line.

7546 The launcher may generate an error message such as the following when it starts:

Xlib: failed to load locale file: /usr/lib/X11/nls/ISO8859-1

Although the error message appears, the utility works.

X Display Manager (XDM)

6019 Setting the login-restrict-host-choices parameter to “true” disables the View menu in
the Login Chooser. The View menu can be reenabled, however, by bringing up the Sort
menu, holding down mouse button 1, and moving to the View menu.

Table 12  Summary of Problems (Continued)
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Accessing NCD Support Files and Utilities
NCD maintains an archive of utilities that are not included on the
NCDware CD-ROM and technical tips on numerous subjects related
to network computer use. To view and retrieve these utilities and
articles you can connect to the archive through FTP or NCD’s World
Wide Web server.

Using FTP
To connect to the archive using FTP:

1. Type the command:
% ftp ftp.ncd.com <CR>

The following prompt is displayed:
Name (ftp.ncd.com: your login name):

2. After the prompt, type the word anonymous or ftp  and press
Return to display the password prompt.
Password:

3. Type your login ID after the password prompt and press Return.
The FTP prompt displays; you can type FTP commands
(including help  for a list of commands).
ftp>

4. For a list of files available on the server, use the get command to
download the file pub/ncd/Archive/ls-lR. (Depending on the
version of UNIX your host is running, you may need to type a
backslash (\)before the -lR portion of the filename.)

Using the World Wide Web
To connect to the World Wide Web server, use a Web browser. NCD’s
URL is http://www.ncd.com.

To see the utilities and tip archives listing, select the Service and
Support page, select your product line (for example, Explora), and
then select Technical Notes.
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In Case of Trouble
If you encounter difficulties, either contact your local NCD
representative or:

❏ Phone NCD Technical Support at (503) 641-2200 or, in the USA,
(800) 800-9599.

❏ Send a FAX to NCD Technical Support at (650) 903-7426
❏ Send e-mail to NCD Technical Support at support@ncd.com

❏ See NCD’s home page at http://www.ncd.com

For information on services available from NCD Technical Support,
contact your NCD representative or send e-mail to info@ncd.com.

Regardless of the method you use to report the problem to NCD, you
must have the following information ready:

❏ Your name and title
❏ Company or organization
❏ Phone number
❏ FAX number
❏ E-mail address
❏ Billing address
❏ Shipping address

❏ For each hardware item:
— Serial number
— Description of the problem
— Type of warranty (Standard, Express, Extended, Express

Exchange, Out-of-Warranty)

❏ For a software problem:
— Problem type: question, enhancement, bug, crash, or other
— Type of host and its operating system release
— Window manager
— Boot Method: TFTP, NFS, PROM, PCMCIA, or MOP

— Model of NCD network computer
— Amount of installed memory
— NCDware version
— NCDware Boot Monitor version
— Detailed problem description
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Comments on This Document
You can send comments, suggestions, or questions about this
document to the NCD Technical Publications Department by Internet
e-mail. Write to techpubs@ncd.com.
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